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 Control de emisoras con Pocket PC 

Manual de usuario para: 

CTR-Remote 
CTR-Server 
CTR-BlueAir  Traducción al castellano EA5KW
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Introducción 
Este manual nos enseñará a operar con los productos CTR para controlar 
nuestras emisoras, producidos por Lynovation. Esta serie de productos permiten 
al usuario controlar las emisoras de radio utilizando Windows  Pocket PCs de la 
serie Pocket PC 2002 o 2003 (también llamado Windows Mobile 2003). 
Las conexiones entre emisora y Pocket PC pueden ser realizadas utilizando el 
un puerto serie, Bluetooth, TCP/IP (Internet), y  Wi-Fi (wireless TCP/IP). 
 
Los productos ofrecidos son los siguientes: 
 
CTR-Remote � Software de control de emisoras para Pocket PC 2002 and 2003 
 
CTR-Rcvr � remote radio control Pocket PC software for the Icom PCR1000 
 
CTR-Server � Software de puerto serie para Windows 95, 98, 2000 y XP que 
permite acceder al CTR-Remote acceder al puerto serie de nuestro PC en el 
cual tenemos conectada la emisora utilizando una conexión de red TCP/IP.  
CTR-BlueAir � Un dispositivo Bluetooth diseñado en exclusiva para hacer de 
interface sin tener una conexión física (cable) a nuestra emisora y que nos 
permite controlarla utilizando nuestro Pocket PC. 
 

SOBRE ESTE MANUAL 
Estas son las reglas que serán utilizadas en este documento:  
 
Pocket PC será llamado PPC 
 
Texto en negrita Se utilizará para los nombres de menú, paths o botones 
 

Por ejemplo: File -> Options -> Set Time significa seleccionar Set Time 
en el menú  Options del menú File 
 

Texto en itálica  Se utilizará para enfatizar la descripción del programa o de 
prestaciones especiales. 
 

Por ejemplo: Ejecute el programa CTR-Server.exe para acceder al puerto 
serie mediante TCP/IP. 
 

Negrita-Itálica Se utilizará cuando debamos tomar precauciones extraordinarias 
Atención: Asegúrese que el trasmisor está conectado a una antena 
antes de trasmitir.  
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MARCAS REGISTRADAS 
La palabra Bluetooth,  sus marcas y logos son propiedad de Bluetooth SIG, Inc.  
y son utilizados por Lynovation bajo licencia. Otras marcas y nombres citados 
pertenecen a sus respectivos propietarios. 
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EL SISTEMA CTR 
Los productos CTR, están diseñados para trabajar en conjunto, cubriendo una 
amplia gama de necesidades para el control de emisoras. Pueden ser utilizados 
tanto por separado como en conjunción con otros programas.  

CTR-REMOTE 
CTR-Remote es un programa para  PPC 
2002/2003 escrito con Microsoft Visual Studio 
.NET. Por este motivo, comparte muchas de las 
virtudes de los programas desarrollados para  
Windows. CTR-Remote nos permite controlar 
muchas opciones de nuestra emisora mediante 
una sencilla pulsación de puntero en la pantalla. 
Independientemente de la emisora seleccionada, 
el programa siempre mostrará el mismo formato 
de pantalla.  
CTR-Remote se puede conectar a la emisora 
usando una conexión directa a través de puerto 
serie (si esta opción la soporta nuestro PPC), 
mediante conexión TCP/IP usando el CTR-Server 
o incluso mediante Bluetooth utilizando el CTR-
BlueAir conectado a nuestra emisora. 

CTR-RCVR 
CTR-Rcvr es una versión especial del CTR-
Remote, destinado exclusivamente para el Icom 
PCR-1000. Dispone de toda la funcionalidad del 
CTR-Remote. Puesto que el PCR-1000 es un 
receptor controlado por el PC, permite además 
controlar el volumen, el squelch, desplazamiento 
IF y el DSP en una pestaña separada llamada 
Lev.Incluye un analizador de espectro básico que 
nos permite sintonizar una señal simplemente 
pulsando con el puntero en la pantalla. 

Los modos de conexión en el CTR-Remote, están 
disponibles en el CTR-Rcvr, incluyendo el 
Bluetoth (Utilizando el adaptador para el CTR-
Blueair) convirtiéndose así en la solución ideal 
para escuchas portables y móviles 
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CTR-SERVER 
CTR-Server Es un programa bajo 
Windows que se ejecuta en nuestro 
PC y permite acceder al puerto 
serie de nuestro PC donde está 
conectada nuestra emisora 
mediante conexión TCP/IP. Esta 
conexión puede ser en red local, 
Wi-Fi o por internet dependiendo de 
sus necesidades. Diseñado para el 
CTR-Remote y CTR-Rcvr,  puede 
trabajar como servidor serie de 
otros programas. 

CTR-BLUEAIR 
CTR-BlueAir es un dispositivo Bluetooth 
basado en el módulo BlueNiceCom III de 
Amber Wireless. El módulo se monta en 
una placa  específica, y está diseñado 
para conectarse directamente a 
conectores mini DIN de 8 pines (YAESU) 
SE alimenta directamente del CAT de la 
radio y hay cables conversores para Icom, 
Kenwood, y Elecraft. 
 

CTR-REMOTE 
Por su propia naturaleza, los PPC es un pequeño dispositivo, y por lo tanto 
también es pequeño su sistema operativo, por estos motivos sus prestaciones 
son limitadas para determinados casos. La filosofía de diseño del CTR-Remote 
ha sido que sea útil para controlar la radio,  y no manejar la radio. 
Entre las limitaciones por ejemplo, comprobará que no existe un manejo de 
memoria con todas las posibilidades específicas que ofrecen nuestros equipos. 
Simplemente porque hay demasiados equipos en el mercado con sus propias 
características y no es posible hacerlo compatible con todos. 
Sin embargo, CTR-Remote contiene una serie de comandos básicos que 
funcionan con Yaesu, Kenwood, Icom, y Elecraft K2. El listado con los modelos 
que se van añadiendo los puede encontrar aquí emisoras soportadas. 
 
Estas son sus funciones básicas: 

 Ajuste y lectura del VFO principal 

 Ajuste y lectura del modo 

 Ajuste de los tonos/DCS y codificación (Solo en FM dependiendo de la 
marca y el modelo) 

 Ajuste de la frecuencia de desplazamiento de repetidor (Solo en FM 
dependiendo de la marca y modelo) 

 Lectura del S-Meter (Según marca y modelo) 
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 Lectura del modo squelch/sin squelch de la emisora (según marca y 
modelo) 

CARACTERÍSTICAS 
CTR-Remote está optimizado para dispositivos equipados con Pocket PC/Mobile 
2003 con posibilidades de conectividad  Wi-Fi y/o Bluetooth. También funciona 
en los Pocket PC 2002 y soporta acceso directo al puerto serie (si está 
disponible) y conexión TCP/IP mediante Microsoft ActiveSync. 

 Controla emisoras Yaesu, Kenwood, Icom, y Elecraft . 

 Entrada directa mediante teclado 

 Soporta el formato ADIF tanto en importación como exportación. 
 Listado de memorias con posibilidad de marcar frecuencias preferidas. 

 Conexión al DX Cluster TCP/IP and Wi-Fi. 

 Exploración de NCDXF/IARU beacon. 

 Plan de bandas configurable, para que se seleccione el modo correcto 
dependiendo de la frecuencia utilizada. 

 Sintonía fina. 

 Anuncio de la frecuencia y el modo mediante voz con posibilidad de 
activar el modo auto.  

 Historial que recuerda las últimas 20 memorias visitadas 

INSTALACIÓN 
La instalación en el PPC se realiza desde un fichero CAB autoinstalable. El 
fichero ZIP que contiene los CAB lo puede descargar desde 
www.lynovation.com/download.htm. Los ficheros CAB están precedidos de un 
número que indica la versión del programa. 

Por ejemplo: CTR_v20215_ARM_CABS.zip indica que se trata del fichero CAB 
del CTR-Remote versión 2.02.15. 

¿Como instalar el programa? 

1. Descomprima el fichero CAB apropiado utilizando WinZip o cualquier otro 
descompresor, después seleccione el fichero CAB apropiado para su PPC, 
comprobará que hay dos ficheros, instale el adecuado. 
 
a. Si se trata de un Pocket PC 2002, use el fichero ARM 
b. Si se trata de un Pocket PC/Mobile 2003, use el fichero ARM4 
 

2. Conecte el PPC al PC utilizando ActiveSync. Utilizando el explorador de 
archivos, copie el fichero CAB en una carpeta del PPC.  
 

3. Una vez copiado en el PPC, seleccione y ejecute el fichero CAB. 
 

NOTA: Posiblemente una vez instalado, en el PPC se abra una ventana que 
le indique que no se ha instalado correctamente porque está escrito para una 
versión anterior del PPC, no haga caso, es un fallo de Microsoft. 

 

http://www.lynovation.com/download.htm
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El programa ya está instalado en el PPC. Verá un icono del CTR en Start -> 
Programs menú. No olvide  crear una carpeta en My Documents donde se 
grabarán los datos de frecuencias y los ficheros de log. 

DESCRIPCION DEL PROGRAMA 

Funciones 
CTR-Remote tiene 4 secciones principales, cada una 
de ellas está separada en una pestaña. 

Control � Elija su emisora, conéctese y controle la 
frecuencia, modo, VFO y exploración. 

Log � Guarde sus QSO en formato ADIF. 

List � Cree sus propias listas con modos, frecuencias, 
notas, etc. 

DX Clstr � Monitorice y use el DX-Cluster en 
cualquier lugar 

 
 

Menús 
File � Cargar y salvar log, listado y actividad en el 
Cluster, definir opciones regionales (fecha y hora), 
seleccionar autoanuncio, y hora del PPC. 

Comm � Selecciona puerto COM y velocidad en 
baudios, dirección TCP/IP y puerto asignado, velocidad 
de comprobación (polling), PTT mode y dirección hex 
de las emisoras  Icom. 

Options � Proporciona opciones adicionales para 
cada pestaña de las funciones. 

NOTE: La velocidad por defecto de polling speed es de 350 milisegundos. Será 
necesario aumentar el valor de este parámetro, si no se actualiza el PPC 
periódicamente. 

OPCIONES DE LA PESTAÑA CONTROL 
Esta pestaña nos da la opción de controlar la radio. En esta sección veremos las 
distintas posibilidades de esta pestaña. 

Nombre, número de la lista y S-meter 
En esta pantalla, se mostrará la información referente 
a la emisora seleccionada, el nombre de la frecuencia 
seleccionada del listado de frecuencias, el indicativo 
del Cluster y la potencia del DX Beacon si tenemos 
activada la opción Beacon Scanning.  
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Si la frecuencia mostrada la tenemos en nuestra lista de frecuencias, será 
mostrado el número de esa lista al que pertenece la memoria utilizada, (en el 
ejemplo M#20. 

Cuando el programa recibe datos del s-meter proporcionados por la radio, lo 
veremos en esta pantalla, en la barra gráfica situada encima del la frecuencia 
utilizada y además en la parte superior derecha. (S4 en el ejemplo) 

VFO control, Save and Log buttons 
El programa dispone de 2 VFO. No se deben confundir 
con los VFO de la emisora. Pulse el botón VFO-A paa 
pasar al VFO-B y viceversa. 

Puntee B=A (o A=B is estamos en el VFO-B) para 
llevar el otro VFO a la frecuencia indicada. 

Puntear Save para grabar las opciones en la pestaña 
List. Se abrirá una venta de edición para que podamos 
poner un nombre determinado u otra información. 

Puntee en Log para salvar los datos en la pestaña 
Log. Igualmente se abrirá una ventana de edición que 
nos permitirá añadir otra información.  

Control de frecuencia 
Hay varias opciones para controlar la frecuencia de la 
radio. Punteando en la pantalla en el recuadro de la 
frecuencia, se abrirá una ventana que permitirá 
introducir la frecuencia mediante entrada directa. Una 
barra horizontal situada bajo el recuadro de la 
frecuencia, nos permitirá movernos fácilmente de un 
lado a otro de la banda. Las flechas arriba/abajo nos 
permiten cambiar de frecuencia en saltos de 1 MHz, 
100 kHz, 10 kHz, 1 kHz, 100 hz, y 10 hz. 

El cambio de banda se realiza con las flechas 
arriba/abajo situado a la izquierda de la frecuencia, 
también con la lista desplegable situada a la izquierda 
bajo la barra de desplazamiento horizontal. 

De acuerdo con el Scan Mode seleccionado,  las flechas arriba/abajo situadas a 
la derecha del recuadro de la frecuencia podremos cambiar la frecuencia actual, 
las últimas frecuencias utilizadas o el listado de frecuencia. 

La opción situada a continuación de la barra horizontal, hace que entremos en el 
modo de sintonía fina. En este modo la barra horizontal sintoniza la frecuencia 
en saltos de 10x, Está debajo del botón Scan (En el ejemplo 1 kHz). 

El botón Scan sirve para activar o desactivar el modo exploración. El color y la 
etiqueta en este botón cambiarán cuando la exploración esté activa. Utilice el 
control Scan Mode para seleccionar el modo de exploración. En el menú Scan-
Options tendremos más posibilidades. 
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Entrada directa de frecuencia 
Punteando en el recuadro de la frecuencia, se abrirá 
un teclado en el cual podremos introducir la frecuencia 
directamente. Esto será tan sencillo como poner la 
frecuencia y pulsar OK.  

Consejo: Introduzca la frecuencia en Mhz, será mas 
fácil. Aquí tenemos unos ejemplos para ver como 
funciona la entra directa de frecuencia: 

Pulsando el 5 se ajusta a 5.000.000 
Pulsando 1.1004 se ajusta a 1.100.400 

Pulsando 10.004 se ajusta a 10.004.000 

Pulsando 100.004 se ajusta a 100.004.000 
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Controles de modo e historial de frecuencias 
El control Mode situado a la izquierda, cuenta con dos 
opciones. Si el recuadro está marcado, estará 
disponible en control manual y podrás seleccionar el 
modo a usar en la emisora desde el listado que 
aparece. Si está desmarcado, se usará el modo que 
tengamos preprogramado en plan de bandas.  El 
control History, situado a la derecha nos permite 
seleccionar una de las últimas 20 frecuencias que 
hayamos utilizado. 

 

 

Scan Mode and Resolution controls 
El control Scan Mode sirve para seleccionar el tipo de 
exploración que utilicemos cuando el botón Scan  esté 
marcado. Disponemos de varios tipos de 
exploración� 

Band � Explora la banda seleccionada usando los 
pasos de frecuencia que hayamos definido con el 
botón de control Resolution (a la derecha de Scan 
Mode) 

Range � Explora el rango de frecuencias definido con 
la opción Range->Edit  
History � Explora las 20 últimas frecuencias visitadas.  

List � Explora las frecuencias almacenadas en la pestaña List 
List->Priority � Explora de la pestaña List  las frecuencias marcadas como 
Priority 
DX Clstr � Conexión al DX cluster (definido en la pestaña DX Clstr) para seguir 
los spots 

Beacon � Activa la exploración de NCDXF/IAUR Beacon  y muestra el 
indicativo, situación y potencia del beacon activo en el área Name.  Este modo 
requiere que el reloj interno del PPC, esté ajustado a la hora exacta. Existen 
varios programas para este cometido incluido el vxUtil que lo puedes descargar 
desde http://www.cam.com/vxutil_pers.html 
 

http://www.cam.com/vxutil_pers.html
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Play y bloqueo 
El botón Play indica meidante voz, la frecuencia y el 
modo en que estamos. Puede ajustar el programa para 
que lo anuncie automáticamente cuando cambiemos 
de frecuencia o modo en File->Options->Auto-
Announce. 

El botón Lock bloquea los controles del CTR-Remote. 
De este modo podremos llevar el PPC en el bolsillo sin 
preocuparnos de que accidentalmente cambiemos los 
parámetros del programa. Pulse nuevamente Lock 
para desbloquear los controles. 

 

 

Opciones FM 
Hay una serie de opciones especiales que se activan 
únicamente en el modo FM. Estas opciones nos 
permiten indicar la frecuencia de desplazamiento 
(Repetidores) y los tonos. 

El Transmit Offset se indica en el recuadro situado a 
la izquierda, y se introduce en Mhz. Esta opción no se 
soportada por todas las emisoras. 

El Tone Mode situado en el centro, nos permitirá 
utilizar la opción para introducir los tonos. Las opciones 
son Ninguna, Tone Encode (T-Encode), Tone Encode y 
Decode (T-Enc/Dec) y DCS. Estas opciones estarán 
disponibles dependiendo de la marca y modelo de 
emisora 

Cuando seleccionemos un tono, la lista de tonos (recuadro situado a la derecha) 
nos permitirá elegir el tono a utilizar. Esta opción ajusta los tonos tanto en TX 
como en RX si la opción T-Enc/Dec está seleccionada y los tonos disponibles en 
la radio se muestran aquí. 

Si el  DCS (Digital Coded Squelch) está activado eliga el código  de la lista 
situada en el recuadro de la derecha. 

NOTE:  Muchas emisoras, no soportan la lectura o ajuste de Tx Offset y 
Tone Mode. De cualquier modo, las opciones indicadas, se limitan a 
ajustar los modos en la emisora. Cuando ejecutemos el programa por 
primera vez, en pantalla veremos los valores por defecto del programa, y 
no los que tengamos programados en la emisora. 
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Selección de la emisora y control en línea 
La selección de la emisora se lleva a cabo 
seleccionando en primer lugar el fabricante y después 
el modelo. Kenwood y Elecraft  no disponen de lista de 
modelos, ya que Kenwood contiene un identificador  
ID# propio. De ese modo el programa determina el 
modelo automáticamente, de Elecraft solo está 
disponible el modelo K2. 

NOTE:  La selección de un modelo Icom ajustará la 
dirección hex de la radio al valor por defecto. Puede 
variar esta dirección en el menú Comm->Icom Adrs en 
caso de ser necesario. 

Una vez seleccionada la emisora, puntee On-line para 
conectar con la radio, cuando esté conectado, serán visibles los botones VFO 
encima de la frecuencia. 

¡Atención 
Asegúrese de seleccionar su modelo correcto. Algunos  comandos 
usados en determinados modelos pueden bloquear otros elegidos 
por error, y será necesario apagar y encender o incluso resetearlos.  

Comprobación en línea 
La Polling Speed en le menú Comm ajusta el periodo en que el programa 
�pregunta� a la emisora si ha habido algún cambio. Por defecto son 350 
mislisegundos. Auméntelo si ve que la lectura del s-meter no se actualiza 
correctamente. 

S-Meter NOTE: Todas las emisoras, no soportan esta opción, y posiblemente no 
veamos el s-meter, compruebe en el manual si la emisora lo permite. Si es 
necesario, ajuste el tiempo de comprobación (Polling) en el menú Com. 

Menú Opciones de exploración 
Desde aquí indicamos como se comportará el 
programa en modo Scan. 

Scan Speed Velocidad de exploración 

Scan Pause Tiempo que el programa se detendrá en 
modo Pause 

Unsqueched determina si Scan se detendrá durante el 
tiempo Scan Pause, portadora,  o se parará cuando se 
abra el squelch. 

S-Mtr determina si Scan se detendrá durante el tiempo 
Scan Pause, portadora,  o se parará cuando  la señal 
s-meter sea igual o superior ai la indicada en S-Mtr >= . 

En el ejemplo la velocidad de exploración es de 500 millisegundos y se detendrá 
si la señal del s-meter es >= a 6. 

NOTE: En algunas emisoras no funcionará esta opción dependiendo de la 
marca y modelo.
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OPCIONES PESTAÑA DE LOG 

Esta pestaña, nos proporciona un log básico para 
anotar nuestros QSO. Los log se archivan en formato 
ADIF, que es compatible con la mayoría de los log de 
nuestro PC. Los ficheros en formato ADIF pueden ser 
cargados directamente en el CTR-Remote. pero dadas 
sus limitaciones, debe tener presente que no 
almacenará todos los campos que tenga en su PC. 

La finalidad del CTR-Remote no es reemplazar nuestro  
programa de log. Simplemente nos ofrece  un método 
�portátil� para anotar nuestros QSO cuando estemos 
portable o móvil (aparcado se entiende) hi.  

 

El log admite los siguientes parámetros� 

QSO Fecha y hora (UTC)  Indicativo 

Frequencia Modo 

Potencia RST-Enviado 

QTH RST-Recibido 

Nombre Comentarios (notas) 

QSL-Enviada QSL-Recibida 

 

Opciones del Menú 

El menú Log-Options permite añadir, editar o borrar 
una entrada. Seleccionando Add o Edit se abrirá una 
ventana de edición donde podremos entrar información 
específica sobre ese contacto. 

Una vez finalizada la edición pulsaremos OK. Para 
salir sin actualizar los cambios pulsaremos Cancel. 

Consejo: Pulsando el  [*] amarillo situado junto a 
Dt/Tm (Date/Time) o Freq se actualizan los datos al 
valor actual. 

Note: Se puede añadir o editar un QSO del log desde 
el menú Log-Options  o punteando en el botón Log en la pestaña de Control. 
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PESTAÑA DE OPCIONES DE LISTA 
En esta pestaña, podremos administrar las frecuencias 
que hayamos almacenado previamente. Se puede 
añadir cualquier número de frecuencias, pero en la 
práctica unas 200 será un valor aceptable, teniendo en 
cuenta las limitaciones en velocidad del sistema de 
ficheros en nuestra PDA. 
Cada entrada, se asocia con un número de memoria 
Memory #.  M#nn se muestra en la pestaña Control 
situada encima del s-meter cuando se selecciona una 
frecuencia de la lista. 

Menú de opciones de la lista 
El menú List-Options nos ofrece una serie de opciones para controlar la lista: 

Toggle Priority Marca la memoria para ser explorada con preferencia 

Priority seleccionar o borrar las marcas 

Sort by ordena la lista por nombre, frecuenca o 
modo. 

Add Añade una nueva frecuencia al final de la 
lista 

Edit Nos permite editar la frecuencia de la lista 
que tengamos seleccionada  

Delete borrará la selección actual 

Track Selected, si lo seleccionamos, hará que 
la radio cambie a la frecuencia seleccionada en 
la lista. De este modo podremos comprobar la actividad en cada memoria 
simplemente pulsando encima de ellas. 

Note:  El fondo cambia de color blanco a azul claro cuando 
tenemos seleccionado Track Selected. 

Ventana de edición de lista 
La ventana List Edit  nos permite fácilmente, crear o 
actualizar los parámetros de las entradas de la lista. 

La lista Edit de la parte superior, nos permite 
seleccionar otra frecuencia sin abandonar esta ventana: 
Utilice el botón Apply para guardar los cambios sin 
salir. 

Si Ud. está conectado a la radio, verá el botón ->Radio. 
Pulsando sobre él, transferirá esos parámetros a tu 
emisora.  

De momento la opción display no funciona. 

Nota: Las opciones TxOffset, TnType, and Tone 
estarán disponibles únicamente en modo FM.  
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OPCIONES DE LA PESTAÑA DX CLSTR 
Los servidores DX Cluster se utilizan para proporcionar a los radioaficionados 
información en tiempo real de las estaciones activas en ese momento en las 
bandas, siendo de extrema utilidad a los cazadores del DX así como a los 
radioescuchas.  Otros colegas de cualquier parte del mundo introducen los spots 
en su cluster local y esos spots son redistribuidos a los demás servidores, 
siendo recibidos por otros colegas en sus cluster locales. Para ampliar la 
información referente al DX cluster y descargar un manual, puede visitar 
http://www.ab5k.net/Home.aspx  

CTR-Remote proporciona una conexión Telnet a cualquier DX cluster. El 
programa dispone de varios servidores preprogramados en el listado de Adrs en 
la cual se pueden añadir los cluster que usamos habitualmente.  

Pantalla DX Clstr  
La pantalla DX cluster consta de varios controles y una 
ventana donde mostrar el texto. 

El indicativo del clúster se muestra en la ventana Call. 
Este es nuestro indicativo, con el que nos conectamos 
al cluster. Si  lo cambiamos, será necesario obtener 
una nueva clave de registro para que el programa sea 
totalmente operacional. Los programas no registrados, 
están limitados a tres QSO por log, por lista y por spots 
del cluster, y cinco minutos de tiempo de conexión. 
Puedes obtener una clave de registro de 
www.lynovation.com. 

 

El control Adrs nos permite elegir el cluster al cual nos 
conectaremos, si no es ninguno de los preprogramados 
tenemos la posibilidad de añadir nuestros preferidos 
con la opción Add,  editar los existente con la opción 
Edit o borrar la dirección seleccionada con Delete, 
simplemente punteando y manteniendo la flecha  
situada en la flecha situada junto al control Adrs  

La dirección del servidor puede ser en formato IP ( 
127.0.0.1)o formato URL (k7ar.net). 

NOTA: El puerto usado por defecto para Telnet 
es el 23. Muchos servidores lo utilizan, no 
obstante puede darse el caso que no sea así. En estos casos debe ser 
introducido el puerto a usar, separado por el símbolo : (dos puntos). (por 
ejemplo: k7ar.net:7300 se conecta a k7ar usando el puerto 7300). 
 

Una vez seleccionado el cluster, pulse el botón Connect para conectar. 

NOTA: Es necesaria una conexión TCP/IP para que funcione esta 
opción. Puede ser a través de ActiveSync entre el PC y su Pocket PC, 
módem telefónico, una tarjeta de red en nuestro PPC, o mediante una 
conexión Wi-Fi. 

 

http://www.ab5k.net/Home.aspx
http://www.lynovation.com
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Conectándonos 
Una vez conectados, la ventana de texto empezará a 
recibir datos del clúster. El programa enviará 
automáticamente su indicativo cuando se lo pida el 
clúster. Si es nuestra primera conexión en ese clúster, 
nos solicitará información adicional. Use los controles 
TX y Send para introducir los datos y enviarlos al 
cluster. Para subir y bajar el texto de la ventana, pulse 
en las flechas de la barra vertical para desplazarse 
arriba y abajo. 

Dispone de varios mensajes y comandos 
preprogramados en el control Tx. Seleccione el 
mensaje deseado de la lista o escriba el que usted 
prefiera y pulse el botón Send para enviarlo al cluster.  

Se pueden añadir, editar o borrar mensajes y comandos al igual que en el 
control Adrs punteando y manteniendo pulsado el control Tx hasta que 
aparezca un menú desplegable. 

Filtrado y QSY automático 
Para hacer que el programa al recibir una spot del 
cluster envíe la instrucción a nuestra emisora y ésta 
haga QSY automáticamente a esa frecuencia marque 
el recuadro Track DX on. En el momento que se reciba 
un spot, la frecuencia será enviada a la emisora.  

NOTA: Punteando en cualquier spot los datos 
serán enviados a la emisora si está conectada. 

Se puede seleccionar un filtro para indicarle al CTR 
que banda o rango de frecuencias queremos que se 
muestren en la pantalla. Este filtro es local, lo que 
significa que solo tendrá valor en nuestro programa, y 
no afectará a las opciones que tengamos seleccionadas en el cluster. 

Para limpiar la pantalla de texto, pulsaremos en el botón Clr  situado a la 
izquierda. 
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Menú DX-Option 
Tenemos cuatro opciones. 

Get Previous Spots envía al cluster el comando 
SHOW/FDX al cluster. Este comando le indica al serve 
que nos muestre los spots mas recientes como texto 
formateado. Si dejamos marcada esta opción, el 
programa descargará automáticamente los últimos 
spots cada vez que nos conectemos. 

Radio Diagnostics Es un comando especial que 
captura y muestra los comandos en formato hex que se 
intercambian entre el programa y la radio. Esta opción 
puede ser útil para diagnosticar problemas de conexión 
o de software. También se puede usar para comprobar 
si el programa está conectado con la emisora. Cada mensaje lleva una etiqueta 
TX (a la radio) o RX (recibido de la radio). Los mensajes se enviarán en el 
formato que utilice la radio. 

Add Whitespace añade un espacio en blanco entre 
cada spot recibido para facilitar su lectura. 

Save to Log  permite salvar el spot seleccionado en 
ese momento en la ventana del Clúster. Esta opción 
solo estará disponible cuando seleccionemos un spot 
de DX en la lista. 

Guardando y abriendo fichero del DX cluster 
El menú File->DX Clstr  permitirá que guardemos la 
información de la ventana DX Clstr a un fichero de 
texto en nuestro PPC. Esto nos puede servir para ser 
usado junto con Radio Diagnostics para comprobar la actividad de la emisora y 
poder diagnosticar problemas. 

Cuando Save DX Clstr File está activo el texto DX Clstri cambia a color rojo, 
indicándonos que los datos están siendo guardados en un fichero: Para 
desactivarlo, pulse nuevamente File->DX Clstr-Save DX Clstr File. 
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CTR-RCVR 
CTR-Rcvr es una adaptación del CTR-Remote realizado específicamente para 
receptores de banda ancha como el Icom PCR1000. 

En la actualidad, el PCR1000 es la única radio soportada por este programa. 
Posteriormente se añadirán otros modelos. 

El programa posee todas las prestaciones y la funcionalidad del CTR-Remote 
Como el PCR1000 es un receptor controlado íntegramente con el ordenador, 
permite una gama mas amplia de controles, se ha añadido un analizador de 
espectro. 

Lea la Sección CTR-Remote para ver las prestaciones básicas de este 
programa. Únicamente las opciones añadidas serán mostradas en este 
apartado. 

NIVELES 
La pestaña Lev es una nueva opción en el CTR-Rcvr. Esta pestaña contiene los 
controles de la radio. Desde aquí puede ajustar el volumen, squelch, 
desplazamiento IF (si tenemos seleccionado alguno de los modos (LSB, USB o 
CW) y controlar las posibilidades del DSP (siempre que esté instalado el módulo 
UT-106). En esta pestaña tendremos también las opciones AGC, NB, atenuador 
y CAF, también un decodificador DTMF. 

Las posiciones relativas de estos controles se muestran en la pestaña Ctrl 
mediante cuatro barras junto al recuadro del filtrado de la lista. 

Los parámetros control, modo y frecuencia se guardan cuando salimos del 
programa. 

BANDSCOPE 
El analizador de espectro, muestra una representación visual de la activdad en 
la banda. El ancho de banda visualizado, depende del paso de frecuencia 
seleccionado. El ancho de banda y la resolución de cada paso se muestra en la 
tabala inferior.  

Frequency 
Step 

Bandwidth Res Frequency 
Step 

Bandwidth Res 

10 Hz 2000 H High 8.33 kHz 400 kHz Med 

100 Hz 20 kHz High 9 kHz 400 kHz Med 

1 kHz 200 kHz High 10 kHz 400 kHz Low 

2 kHz 400 kHz High 12 kHz 400 kHz Low 

5 kHz 400 kHz Med 15 kHz 400 kHz Low 

6.25 kHz 400 kHz Med 20 kHz 400 kHz Low 

 

Como norma general, utilice un paso de frecuencia bajo, si utilizamos un paso 
de frecuencia alto, la resolución será mayor, pero la actualización del espectro 
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será mas lenta. Se recomienda un paso de10 khz cuando estemos cambiando 
de banda para ver la actividad, una vez localizado el tráfico en la banda baje a 1 
ó 2  Khz. Para sintonía fina de una señal baje el paso a 100 Hz. 

Iniciando el analizador de espectro 
El analizador de espectro, es tratado como modo escaner y está incluido en la 
lista Scan Type. Seleccione Scope de la lista y puntee en el botón Scan para 
activarlo. La etiqueta del botón Scan  cambiará a SCOPE mientras el analizador 
de espectro esté activado. Los otros modos de exploración están desactivados 
mientras el analizador de espectro esté activado. 

Que nos muestra el analizador de espectro 
El centro del analizador de espectro, es la 
frecuencia que se muestra en el display. El 
analizador nos permite ver una �imagen� del 
espectro próximo a la frecuencia. Las señales en 
este paso de banda, son mostradas 
verticalmente en el display del espectro. Cuanto 
mayor sean las señales recibidas, presentarán 
los picos más altos en el gráfico. Las señales 
moduladas se verán mas amplias y ocuparán un 
espacio mas grande en el display  Puedes 
sintonizar fácilmente la radio en cualquier señal 
del display simplemente pulsando con el puntero 
en la señal. Es posible que la radio no se 
desplace a la frecuencia exacta debida a la 
resolución del display. Una vez se actualice el 
analizador de espectro, si la señal no está 
centrada, pulse nuevamente en la pantalla. Una vez centrada la señal ya podrá 
escuchar el tráfico de esa frecuencia. 

NOTA: El PCR1000 no soporta los modos LSB, USB, y CW en el modo 
bandscope.  

Las otras opciones de sintonía están disponibles para ir al centro de la 
frecuencia del analizador de espectro. 

Sensibilidad del analizador de espectro 
El analizador viene ajustado por defecto en la posición mas sensible, por este 
motivo las señales fuertes pueden salirse fuera del display. Para ajustar la 
sensibilidad, desplace la barra de scroll situada a la izquierda del analizador a su 
posición mas alta. Esto disminuirá la sensibilidad y permitirá que las señales 
fuertes vuelvan a aparecer dentro del rango seleccionado. 

Max hold 
Es posible que desee capturar la actividad en el analizador de espectro durante 
un periodo de tiempo. Si es así pulse el botón verde, a la derecha del 
Bandscope, este se pondrá de color rojo y capturará el nivel mas alto que 
detecte en cada pasada. Pulsando Max Hold otra vez, volverá al display normal. 
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Sobre bandscope 
El bandscope no es un instrumento de precisión. No está calibrado axialmente ni 
vertical ni horizontalmente. Por este motivo a pesar del nombre que se le está 
dando en la traducción al español, se debe entender como una ayuda para 
sintonizar y en ningún caso como analizador de espectro. Una vez lo utilice, ya 
no querrá utilizar la radio sin tener esta opción activada. 

 

CTR-SERVER 
CTR-Server es un servidor de puerto seria. Se ejecuta en el PC y permite que 
los puertos serie sean visibles en la conexión a una red TCP/IP. La conexión de 
red se realiza en nuestra red local (LAN), internet (WAN) o una red WI-FI. 
Microsoft ActiveSync que nos facilita Microsoft para comunicar nuestra PDA con 
el PC, también nos permite usar una conexión TCP/IP. 

INSTALACIÓN CTR-SERVER 
CTR-Server ha sido desarrollado en Visual Basic 6.0 y viene con un programa 
de instalación llamado Setup.exe el cual, nos guiará durante el proceso de 
instalación. 

Como instalarlo � 

 Descargar el último paquete de instalación desde 
www.lynovation.com.  
 
NOTA: El número correspondiente a la versión lo podremos ver en el 
nombre de fichero (ejemplo. CTR-Server_v10006.zip contiene CTR-
Server v1.00.06) 

 Si nuestro programa para descomprimir, dispone de la opción Install 
pulse este botón para instalar el programa. En caso de no ser así, 
descomprima todo el programa en un fichero temporal y desde allí 
ejecute el fichero Setup.exe. 

 Siga las instrucciones para instalar el programa. Se recomiendo 
utilizar los valores por defecto. 

 El programa de instalación, creará un nuevo menú en Start->All 
Programs llamado CTR. En este menú tendremos el acceso directo 
del CTR-Server. 
 
CONSEJO: Para que se ejecute automáticamente el CTR-Server al 
iniciar nuestro PC, copiar el acceso directo CTR-Server dentro de la 
carpeta Startup. 

DESINSTALACIÓN CTR-SERVER 
Si fuese necesario desinstalar CTR-Server de su PC, vaya a la opción Añadir o 
Quitar programas del panel de control. 

http://www.lynovation.com
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CTR-BLUEAIR 
CTR-BlueAir es un dispositivo para llevar la señal 
que recibe nuestra emisora a través del puerto 
serie al Bluetooth y de este modo podremos 
controlarla mediante nuestro Pocket PC, o 
cualquier otra PDA, PC Palm o Mac con un 
programa de control de radio que soporte 
Bluetooth. No es necesario ningún cable adicional 
ni adaptadores para las emisoras Yaesu (Existen 
adaptadores para emisoras Kenwood, Icom, y Elecraft).  
 
El modulo Bluetooth ha sido diseñado para ser utilizado con el Puerto CAT de 
las Yaesu (8-pin mini), el motivo de esto es que una de las patillas de este mini �
DIN dispone de la tensión necesario para hacer funcionar el dispositivo sin 
necesidad de corriente externa. Es tan sencillo como conectarlo en nuestra 
Yaesu y configurar la connexion.. 

POSIBILIDADES 
CTR-BlueAir nos permite: 

 Control de nuestra emisora mediente Bluetooth 

 Funciona con Pocket PC, notebooks y PC de sobremesa 

 Basado en el Amber-Wireless BlueNiceCom III module 

 Instalación y configuración muy sencilla 

 Alimentado por el puerto CAT de Yaesu 

 Ideal para el uso portable y móvil 

 Genial para casa, no es necesaria un server TCP/IP Wi-Fi para el control  

 Compatible con otras marcas de emisoras usando un adaptador 

 Especificaciones 

Bluetooth module National LMX9820ASM Class 2 Serial 

Input voltage 5 to 14 VDC 

Tx/Rx current typ. 65/62 mA 

Frequency Band 2.4 GHz 

Output power 0 dBm 

Sensitivity typ. -77dBm 

Antenna Integrated chip-antenna 

Interface Level  TTL 

Certifications EN, FCC, SIG 

Temperature -30°C to +80°C 
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CONFIGURACIÓN POCKET PC  
Para  configurar el CTR-BlueAir con su Pocket PC siga los siguientes pasos:  
 
1. Compruebe que la emisora y el CTR-Blueair  están configurados con la 

misma velocidad en baudios. 
 
NOTA: En la mayoría de las radios se puede modificar la velocidad en 
baudios, sin embargo el CTR-Blueair debe ser programado en fábrica. Si 
piensa utilizarlo con mas de una radio, téngalo presente para asegurarse que 
todas sus emisoras pueden ser programadas a esa velocidad en baudios. 
 

2. Conecte  el CTR-Bluetooth a su emisora y póngalo en funcionamiento 
(interruptor situado junto a los LED). El LED verde nos indicará que el 
dispositivo está en marcha. 
 

3. En el PC, active el  Bluetooth. Normalmente se 
hace desde Settings -> Connections -> Bluetooth -> 
Bluetooth Settings. También debe seleccionar la 
opción Accesibilidad y Servicios desde aquí. 
 
 
 
 
 
 
 
 

 
4.  En  Accesibilidad, marque las opciones que se 

muestran a la derecha. 
 
 
 
 
 
 
 
 
 
 
 

5. En Servicios,  seleccione el Puerto Serie y marque 
todas las opciones restantes. 
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6. Pulse el botón Avanzado...  Servicios and 
compruebe el nº de Puerto Com de Salida.  
 
Éste es el puerto COM que deberás seleccionr en el 
CTR-Remote para  conectar el CTR-BlueAir dongle.  
 
Si va a utilizar siempre este dispositivo con éste 
puerto COM, desmarque la opción situada bajo el 
número de puerto. 
 
 
 
 
 

7. En el menú Comm del CTR-Remote, seleccione 
Outbound COM Port que está en Bluetooth 
Settings. La velocidad de Baud  no es importante 
pues que no es utilizada por el puerto Bluetooth. 
 
 
 
 
 
 
 
 
 

8. Pulse en la marca On-line del CTR-Remote. La 
Bluetooth Connection Wizard se abrirá tal como se 
muestra a la derecha. En la pantalla veremos el 
CTR-BlueAir con el nombre que hayamos elegido 
cuando lo compramos. Si no lo visualizamos, sera 
necesario puntear el botón Refresh situado en la 
parte inferior de la pantalla. 
 
NOTA: El dispositivo en la pantalla aparecerá con 
un símbolo de interrogación, esto se debe aque el 
sistema no reconoce este dispositivo. 
 
 

9. Puntee en el icono del dispositivo y aparecerá la 
opción Bluetooth Authentication. Introduzca los 4 
dígitos elegidos como password  y pulse el botón 
OK. 
 
NOTA: Solo es necesario parear el dispositivo una 
vez. Una vez realizado ya permanecerá pareado y 
lo reconocerá automáticamente. 
 

10. Si todo lo hemos realizado correctamente, el LED 
azul del dispositivo se encenderá y serás devuelto 
al CTR-Remote. 
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CONFIGURACION PC 
Muchos preguntan si el CTR-Blueair es compatible con los Bluetooth de 
nuestros PC�s o PC Portátiles La respuesta es que¡¡¡ si !!! El único requisito, es 
que el programa que vaya a utilizar, debe estar preparado para utilizar el 
Bluetooth. La mauoría de los programas actuales, son capaces de reconocer el 
Puerto Bluetooth. 

Si el programa no reconoce el puerto, o falla cuando tratamos de abrirlo, pruebe 
lo siguiente: 

 Es necesario usar el Microsoft Bluetooth stack que va incluido en el 
Windows version SP2. El Widcomm Bluetooth stack que proveen la 
mayoría de los adaptadores de Bluetooth, tiene muchos fallos y en 
algunos programas se traducen estos fallos en un error cuando se trata 
de conectar al puerto virtual del Widcomm. 

 El adaptador Bluetooth que utilice en su PC debe aparecer en la lista que 
encontraremos en esta dirección:  
http://support.microsoft.com/kb/841803/EN-US/ 

Ham Radio Deluxe y 817 Commander son dos programas que algunas veces 
fallan al utilizar el Widcomm y no reconoce el puerto Bluetooth  con Windows 
CP. Para hacerlo funcionar sera necesario editar el registro de Windows. Los 
pasos indicados seguidamente nos explican como hacerlo.  

NOTA: Estos cambios, permitirán utilizar  el HamRadio de Luxe y al 817 
commander, ya que reconocerán el Puerto Bluetooth,  no obstante estos 
cambios son temporales,  esto significa que cuando reiniciemos el 
ordenador, volverán a sus valores originales.  

ATENCION! 

Editando el registro de nuestro ordenador, es una operación 
delicada, si no está seguro de lo que hace es preferible que NO lo 
haga. Si no sabe lo que está haciendo puede causar daños 
importantes a Windows, e impedir que arranque con normalidad.  
Ejecute RegEdit.exe 

1.  Vaya a: 
HKEY_LOCAL_MACHINE\HARDWARE\DEVICEMAP\SERIALCOMM\ 

 

http://support.microsoft.com/kb/841803/EN-US/
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2. Localice el puerto Outgoing Port que ya configuramos anteriormente en el 
adaptador Bluetooth. En este caso era el COM12. El Outgoing Port lo 
podremos encontrar en Control Panel -> Bluetooth Devices -> Comm 
Ports en Windows XP. 
 
NOTA: El valor de la cadena a buscar es \Device\BthModem0 
 

3. Pulse el botón derecho y seleccione Delete en el menú desplegable. 

4. Right-click on the white space (below COM13 in the screen above), and 
select New -> String Value 

5. Teclee lo siguiente: \Device\Serialx donde x es el siguiente puerto (note que  
Serial 0 existe, por este motivo yo usé Serial1) 

 

6. Pulse el botón derecho en el siguiente dispositivo serial y seleccione Modify. 
Seguidamente introduzca COMx donde x es el Outgoing COM de su 
dispositivo Bluetooth (COM12 en el ejemplo). 
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AUDIO REMOTO 
A pesar de que el CTR-Remote no permite escuchar directamente el audio a y 
desde la emisora, hay disponibles varios programas que nos sirven para este 
cometido. El programa que hemos encontrado que funciona perfectamente, es 
fácil de instalar y de configurar, y permite audio en los dos sentidos es Microsoft 
Portrait. Este programa no solo nos permite recibir y enviar el audio entre el 
Pocket PC y el PC, si no que además el retardo del buffer es menor de un 
segundo y además nos permite incluso enviar y recibir vídeo. Únicamente 
comentaremos la posibilidad de el audio, ya que es lo que nos interesa para el 
CTR-Remote. No obstante se recomienda experimentar con el programa para 
ver la posibilidad enviar y recibir SSTV vía Wi-Fi ¿alguien se anima? 

MICROSOFT PORTRAIT 
En primer lugar descargue e instale el programa Microsoft Portrait on you PC y 
en el Pocket PC. Hay dos programas uno para cada sistema operativo. Visite 
http://research.microsoft.com/~jiangli/portrait para descargarlos.  

Una vez tenga instalado y configurado el software, actuará como un 
intercomunicador TCP/IP.  

PC Configuration 
La versión de PC del Portrait necesita 
unos ajustes mínimos.  

1. Inicie Portrait en su PC 
 
 
 
 
 
 
 
 
 
 
 

 

2.  Seleccione el menú Tool -> 
Options... y seleccione Audio 
tab 

a. Compruebe que la opción 
Recording y Playback y 
sus ajustes son los 
adecuados para su tarjeta 
de sonido 

b. Seleccione GSM 6.10 
(13Kbps) Codec si no está 
seleccionado antes, y 
cierre esta opción. 

http://research.microsoft.com/~jiangli/portrait
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3. En el menú Call, selecione Reconnect After Time Out para volverse a 
reconectar, si acaso falla la red de forma que acepte automáticamente 
las llamadas Automatically Accept Calls de este modo podrá 
reconectar remotamente si es necesario. 

4. Deje el programa activo en su PC. 

Configuración Pocket PC 
La versión Pocket PC tambien es muy sencilla en sus ajustes.  

1.  Ejecute Portrait en su Pocket PC. 

 
 
 
 
 
 
 
 
 
 

 

2. Seleccione Tools -> Options... y pulse la 
pestaña Audio 

a. Seleccione GSM 6.10 (13Kbps), Half-
duplex 

b. Elija Press and talk o Click to talk 
dependiendo de su elección podrá 
seleccionar, transmitir audio 
manteniendo pulsado el botón de la 
pantalla o bien un punteo ON/OFF que 
activará o desactivará el PTT. 
Seguidamente cierre la ventana 
Options. 
 
 
 

3. En el menu Call, seleccione Reconnect After Time Out paar que se 
reconecte en caso de que falle la red y acepte las llamadas entrants de 
modo automático (Automatically Accept Calls) 

Configuración de la radio 
La manera mas sencilla de conectar nuestro receptor es sencillamente conectar 
un jack en el Line-in de nuestra tarjeta de sonido del PC. Esto permitirá 
conectarnos con un mínimo esfuerzo. La conexión del audio de transmisión a 
nuestra emisora, será un poco mas complicado, pero estas conexiones están 
bien documentadas en otras webs y en muchas revistas. 
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Iniciando la conexión 
Conectando desde el PC 
Para conectarse entre el PC y el Pocket PC Portrait, haga una llamada desde un 
programa a otro.  

1.  En la versión 2.3 del programa, 
el PC puede llamar al Pocket PC 
introduciendo el nombre del 
Pocket PC's en el listado de 
llamadas y punteando Call. 
 
 
 
 
 
 
 
 
 
 
 

2.  Una vez le Pocket PC recibe la solicitud de 
connexion, aparecerá una ventana en la que 
nos pedirá permiso para conectar. Para 
aceptarla debemos pulsar Call-OK. Si 
seleccionamos Automatically Accept Calls  en 
el Pocket PC, la llamada sera aceptada de 
forma automática. 
 
 
 
 
 

3. Tras realizar la connexion, el botón Talk se 
activará y el botón Call-OK quedará inactivo. 
 
En este momento deberíamos escuchar el 
audio de nuestra emisora en nuestro Pocket 
PC, si pulsamos el botón Talk podremos hablar 
y nuestra voz sera enviada al PC y podremos 
escucharnos por los altavoces de nuestro 
ordenador. Para desconectar simplemente 
pulsaremos el botón Cancel. 
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Conexión desde el Pocket PC 

El procedimiento a seguir, es similar en el Pocket PC. 

1. Escriba la dirección TCP/IP address o el 
nombre de nuestra red en nuestro PC y 
seguidamente pulsaermos Call-Ok. 

 

 

 
 

 

 

 

2.  

Veremos una ventana en el PC que nos preguntará si aceptamos la 
llamada, pulsmos Accept. Si seleccionamos Automatically Accept 
Calls  en el Pocket PC, la llamada sera aceptada de forma automática. 
. 

3. Tras realizar la connexion, el botón Talk se 
activará y el botón Call-OK quedará inactivo. 
 
En este momento deberíamos escuchar el 
audio de nuestra emisora en nuestro Pocket 
PC, si pulsamos el botón Talk podremos hablar 
y nuestra voz sera enviada al PC y podremos 
escucharnos por los altavoces de nuestro 
ordenador. Para desconectar simplemente 
pulsaremos el botón Cancel. 

4. Para desconectar simplemente pulsaremos el 
botón Cancel. 

PRODUCTOS PROXIMAMENTE 
La línea de productos CTR continúa trabajando y desarrollando estos 
programas. Periódicamente son añadidas nuevas emisoras al CTR-Remote y 
esperamos que en un futuro que se puedan utilizar los modos digitales. 

CTR-Rcvr, nuestro último producto, permite controlar el receptor Icom PCR1000. 
Se irán ampliando el número de receptores conforme vaya siendo necesario. 

Queda claro que el usuario final es el que mejor puede colaborar al desarrollo de 
un sistema como puede ser el CTR, por este motivo se admite todo tipo de 
críticas e ideas que puedan contribuir a su mejora. Si tienes una idea o 
sugerencia, por favor contacta con info@lynovation.com 

Gracias y 73, Lynn, KU7Q 

mailto:info@lynovation.com

